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Preface vii 

Preface 
This document describes the following steps to install the MICROS Gateway Device Handler 
(MGDH) and the Oracle Payment Interface (OPI). 

• Installing the MGDH  
• Installing the Oracle Payment Interface  
• Configuring the POS for the OPI using the MGDH  
• Using the Middleware mode or the Terminal mode with Pay@Table 

Connecting the Oracle Payment Interface with the Oracle Hospitality RES POS native driver is 
described in another document. The Oracle Payment Interface Oracle Hospitality RES POS 
Installation Guide contains more information.  

Audience 
This document is intended for installers of the OPI and MGDH. 

Customer Support 
To contact Oracle Customer Support, access My Oracle Support at the following URL: 
https://support.oracle.com 

When contacting Customer Support, please provide the following: 
• Product version and program/module name 
• Functional and technical description of the problem (include business impact) 
• Detailed step-by-step instructions to re-create 
• Exact error message received and any associated log files 
• Screen shots of each step you take 

Documentation 
Oracle Hospitality product documentation is available on the Oracle Help Center at 
http://docs.oracle.com/en/industries/hospitality/ 

Revision History 
Date Description of Change 

September 2016 • Initial publication 

February 2017 • Revised formatting and made edits 
 
 
 

https://support.oracle.com/
http://docs.oracle.com/en/industries/hospitality/
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1  Pre-Installation Steps 
Before Installing the OPI 

Complete the following tasks before installing: 

• The application requires Microsoft .NET Framework version 4.0 or higher.   
• You cannot upgrade from previous versions of MGDH to version 6.1.0.9. 
• You cannot upgrade from previous versions of MPG and OPI to OPI version 

6.1.0.9. 
• If a previous MGDH installation exists, go to Programs and Features to uninstall 

the previous MGDH installation, then you can install the latest MGDH release. 
• Verify with the merchant to setup table service (TSR) or quick service (QSR), or 

both.  QSR does not support tips. 
• Verify with the merchant if activating the Refund functionality, the merchant 

must control the privilege for this function.  
• Verify with the merchant if they offer a guest the option to get cash back with 

their purchase, then activate the Sale & Cash option. This is only available for 
QSR.  

• Confirm Microsoft Visual C++ 2010 is installed on the computer where MGDH 
and OPI are installed.  

• Oracle Payment Interface requires at least 6 GB of free disk space.  
• You must install both MGDH and OPI as a System Administrator. 
• You must enter the user name and password of a Microsoft Windows local 

administrator during the installation.   
• You must enter the MICROS database user name and password to install 

MGDH. 
 
During the installation you must confirm the following: 

• Merchant ID’s  
• Receipt header details 
• Tender Media numbers for each card type 
• IP address of the OPI Server  
• IP address of the POS Server  
• If there is an existing MySQL database installed, then the SQL root password is 

required. 
• Workstation IDs and IPs that integrate with the PIN pad. 
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2  Network Considerations 
You must consider the following points for the network: 

• OPI listens on the TCP port 5098 for incoming messages from MGDH, this port 
must be open internally on the merchant’s network. 

• The port for the PIN pad depends the partner, confirm with the partner and 
confirm the corresponding port is open. 
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3  9700 Server Configuration 
Adding an Interface 

To configure the 9700 Server you must add a new interface.  
1. In the Enterprise Management Console, go to the Interface tab. 
2. Define the following Interface values. 

Table 3-1 Insert Interfaces 

Interface Value 

System Name MGDH 

Service Type 
Communication Type 
Timeout 
ISL Script Name 

PMS /SIM 
TCP/IP 
210 
pms7 

 

3. Select the check box to enable the option to Use 19 Digit Reference Entry for PMS 
Inquiries. 

 

 
Figure 3-1 EMC Interfaces tab 
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Configuring RVC 
To configure the RVC, link the interface MGDH to each RVC. 

1. Go to the Enterprise Management Console. 
2. Go to the RVC Parameters tab and link the MGDH interface to each RVC. 

 
Table 3-2 EMC RVC Parameters 
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If the RVC is configured in QSR mode, then activate the options below: 
• Select the check box Do Not Prompt for Tips (No Overtendering if Charge Tip is 

Required).  
• Select Allow Fast Transactions. 

 
Figure 3-2 EMC RVC Parameters General Options 
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If using the TSR mode, do not activate this option. On the Format tab, configure and 
enable the following options for the TSR RVC’s: 

1. Define the Number of Guest Check Information Lines as 30. 
2. Select the check box Skip Blank Lines When Print or Display Guest Check Info 

Lines. 

 
 

Figure 3-3 EMC RVC Parameters Format Options 
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Employee Configuration 
1. Go to the Employee Maintenance tab, select the Cashier employee class. 
2. Select the check box to activate the ISL Employee Option #4 option to define the 

employee class that can process a refund. 

 
Figure 3-4 EMC Employee Maintenance - Employee Classes 
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3. Enable the Authorize/Perform Closing of Checks with a Negative Balance 
Tenders option. 

 
Figure 3-5 EMC Employee Maintenance Tenders Options 
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Service Charges 
If the merchant provides a Cash Back option, then add a new Service Charge for the CashBack 
option. This is the same as the Open Amount Service Charge. You can skip this step if the 
merchant does not activate the SalesCash function. 

 
Figure 3-6 EMC Service Charges Options 
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Configuring Tender Media Records 
Configure the following options for the credit/debit card tenders. 

1. In the Enterprise Management Console, go to the Tender Media tab. 
2. Select the Options tab and select the category Interface Options.  
3. Activate the PMS and Credit Card use 19 Digit Acct Number option. 

 
Figure 3-7 EMC Tender Media Options 

 
To configure the credit card options: 

1. Go to Options tab select Credit Card Options. 
2. Deactivate all options and remove the floor limit/preambles list. 
3. Enable the No Credit Card Length Check option. 
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To configure the POS options: 

1. Go to the Options tab and select POS Behavior, to active the following options: 
• Assume Paid in Full 
• Reference Entry Required 

2. Deactivate the following options: 
• Mask Account Number 
• Encrypt Tender/Media Reference Entry 

3. Link the tender to Open amount Service Charge for TSR environments. 
4. Add the debit tender option the same way you would for normal credit card 

tenders. 
5. Add the new tender SaleCash option the same way as a normal credit card 

tender. You can skip this step if the merchant does not activate the SaleCash 
function. 

Note: The SaleCash tender is only supported when utilized in a Quick Service 
Restaurant (QSR) environment. 

 

 
Figure 3-8 EMC Tender Media POS Behavior Options 
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Touch Screen Design 
First, contact the Oracle Hospitality Consulting Team for confirmation, and then if required, add 
the following buttons to the payment screen. The key types are Functions and you can link them to 
the MGDH interface. 

Table 3-3 Table Service Restaurant (TSR) Payment Screen 

Field  Value  

CC PAY SIM INQ #2 

CC REFUND SIM INQ #4 

CC AUTH SIM INQ #8 

CC FINAL SIM INQ #9 

TAB AUTH SIM INQ #12 

BALANCE INQUIRY SIM INQ #14 

CC REPRINT SIM INQ #7 

CC REPOST SIM INQ #16 

MANUAL AUTH SIM INQ #15 

REFUND MANUAL SIM INQ #11 

Table 3-4 Quick Service Restaurant (QSR) Payment Screen 

Field Value 

QSR SALE SIM INQ #1 

SALE CASH SIM INQ #5 

CC REFUND SIM INQ #4 

BALANCE INQUIRY SIM INQ #14 

CC REPRINT SIM INQ #7 

CC REPOST  SIM INQ #16 

REFUND MANUAL SIM INQ #11 
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The OPI shares the VOID touchscreen key with the 9700 POS. Using the VOID key you 
can: 

• Void the transaction 
• Add Tips (for TSR only) 

 
Figure 3-9 EMC Touchscreen Design Module 
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4  Installing the MGDH Driver  
Installing MGDH on the Simphony Server 

1. Double-click the MGDH installer to start the installation. 
2. Click Next. 
3. Browse to select the location to install MGDH. 

 
Figure 4-1 MGDH OPI Installation Package 
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4. Click Next. 
5. Enter your database information. 

Table 4-1 MGDH Database Information Settings 

Field Value 

Database Type MSSQL 

DB Server localhost 

Database Name mcrspos 

 

 
Figure 4-2 MGDH POS Config Files Setup 

6. Click Next. 
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7. Select the property. 

 
Figure 4-3 MGDH POS Config Property Setup 

8. Select Next. 
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9. Select the Currency and Single MerchantID or Multiple MerchantID.  
10. Enter the MID number, in this case enter the Single MerchantID and click Next. 

If needed, you can confirm the MerchantID setup configuration with the Oracle 
Hospitality Consulting Team. 

 
Figure 4-4 MGDH POS Config RVC Currency Setup 
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11. Select the RVC mode for the RVCs under the property. TSR is for Table Service 
and QSR is for Quick Service, which enables the No Tip option and click Next. 

 
Figure 4-5 MGDH POS Config setup - RVC Map 
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12. Header and Trailer information is configured by the partner and the partner 
who responds with all of the print data, therefore, you do not need to configure 
the following information.  

13. Click OK. 

 
Figure 4-6 MGDH RVC Header Editor 
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14. You can match the tender from the drop-down list for the card types and enter 
the CashBack service charge number for Cashback_svc. If the tender is not used, 
skip this step. 

15. Click Next. 

 
Figure 4-7 MGDH Tender Map 
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16. Select the check box to enable the required options. You can double-click the 
Trans Option Description to access detailed descriptions for the transaction 
options. 

17. Click Next. 

 
Figure 4-8 MGDH Transaction Options 
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18. Select the options required for the merchant. 
19. Click Next. 

 
Figure 4-9 MGDH Print Options 
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20. Enter the following information: 

Table 4-2 MGDH Server Setup Options 

Option Value 

Host1 HTTP OPI Server IP address, for example: 
https://127.0.0.1 

Host1 Port OPI port, you can use the default 5098 

TIMEOUT MGDH timeout, you can use the default 60 
seconds 

 

 
Figure 4-10 MGDH Server Options 

  

https://127.0.0.1/
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21. Click Next and enter the following information for the POSEOD: 

Table 4-3 MGDH POSEOD Setup Options 

Option Value 

Server OPI Server, same with last step 

Server port OPI port, same with last step 

TIMEOUT(POSEOD) EOD TIMEOUT, you can use the default 
value 80 

Device Merchant ID The MID or MID’s required for the RVCs 

Multiple MID There must be a “|” between the MIDs 

 

 
Figure 4-11 MGDH POSEOD Setup Options 

22. Click Next. 
 
  



 

4-12 Installing the MGDH Driver 

23. Click OK. 

 
Figure 4-12 MGDH File Creation Confirmation Screen 
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24. Click Install. 

 
Figure 4-13 MGDH OPI Installation Screen 
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25. If you need to edit the files configured during a previous installation, then you 
can select the available Edit options to edit the files and click Next. 

 
Figure 4-14 MGDH OPI Edit Files Screen 
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26. Click Next. 

 
Figure 4-15 MGDH Modules Installation Screen 

 
  



 

4-16 Installing the MGDH Driver 

27. A restart of the computer is not required. 
28. Click Finish. 

 
Figure 4-16 MGDH OPI Installation Completion Prompt 
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Point-of-Sale (POS) End-of-Day (EOD) 
You can use the Microsoft Windows Task Scheduler to run the OPI POSEOD using the 
following configuration details. 

Table 4-4 Microsoft Windows Task Scheduler Settings 

Temporary Table 

Name OPI POSEOD 

Description Generates the OPI transaction report 

Trigger Daily 

Action Start a program 

Program/script Browse to find the POSEOD.exe in 
MGDHDriver directory 

Add arguments (optional) The upper level of the POSEOD.exe path 

Start in (optional) The upper level of the POSEOD.exe path 

For more information on how to setup the Microsoft Windows Task scheduler visit the Microsoft 
website at: http://www.microsoft.com 
 
 

http://www.microsoft.com/
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5  Installing the OPI 
OPI Installation Steps 

Complete the following steps to install OPI. 

1. Double-click the OPI installer desktop icon. 

 
Table 5-1 OPI Installer Desktop Icon 

2. Click Next. 

 
Figure 5-1 OPI Installation Wizard 
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3. Verifying your computer and validating the required software takes around 10 
seconds. 

 
Figure 5-2 OPI Setup Validation Screen 
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4. If the target computer doesn’t have MySQL installed, then the OPI installs the 
MySQL database. If MySQL is already installed, then the OPI uses the existing 
MySQL database and you must enter your MySQL logon credentials. 

5. Click Next. 

 
Figure 5-3 OPI Components Installation Screen 
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6. Setup a MySQL password to use for creating the Database Schema. 

 
Figure 5-4 OPI MySQL Root Password Setup 
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7. Click Next to continue and enter a Username and Password to create a database 
user for the OPI and click Next. 

 
Figure 5-5 OPI Creating a DB User 
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8. Select POS, MGDH, and then click Next. 

 
Figure 5-6 OPI Communication Channel Selection Screen 
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9. Enter and confirm your password to secure a certificate for the OPI to use during 
MGDH communication, and click Next. 

 
Figure 5-7 OPI Configuring POS Communication Screen 
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10. Enter the date and time you want to schedule a weekly restart of the OPI Service. 

 
Figure 5-8 OPI Service Restart Task Scheduler 
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11. Select the destination drive location where to install the OPI and click Next. 

 
Figure 5-9 OPI Select Destination Location Screen 
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12. Click Next. 

 
Figure 5-10 OPI Open Source Project Code and License Storage Locations 
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13. Click Next. 

 
Figure 5-11 OPI Select Start Menu Folder 
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14. Verify your previous installation settings, and if correct, click Install. 

 
Figure 5-12 OPI Installation Screen 
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15. The installation of the OPI and MySQL starts and may take several minutes. 
Upon completion, you can now configure the OPI. 

 
Figure 5-13 OPI Installation Progress Screen 
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Configuring the OPI  
Complete the following steps to configure the OPI: 

1. Log in using your Microsoft Windows System Administrator credentials. 

 
Figure 5-14 OPI Configuration Tool - Terminal Mode 

2. Click Next. 
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3. Enter the following information to configure the OPI Terminal mode: 

Table 5-2 OPI Terminal Mode Configuration Settings 

Field Value 

POS Interface  Enable 

OPI Mode Terminal 

 

 
Table 5-3 OPI Terminal Mode Settings 
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4. Click Next, and configure the OPI Middleware mode by entering the following 
information: 

Table 5-4 OPI Middleware Mode Configuration Settings 

Field Value 

POS Interface Enable 

OPI Mode Middleware 

PrimaryHost  Confirm with Oracle Consulting Team 

BackupHost  Confirm with Oracle Consulting Team 

 

 
Table 5-5 OPI Middleware Mode Settings 
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5. Select POS Configuration. 

 
Figure 5-15 OPI POS Configuration 
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6. Select the Add New Property button. 

 
Figure 5-16 OPI Add New Property Screen 
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7. Configure the merchant details using the following information: 

Table 5-6 OPI Merchant Details Configuration 

Temporary Table 

POS Type 9700 

Merchant ID  MID, same with the MGDH Merchant ID 

Pay@Table Disable 

Merchant Name Merchant Name 

Merchant City City where the merchant is located 

Merchant Country Merchant’s Country 

• If multiple merchants have multiple MID’s, refer to the steps listed above to 
Add New Property again or contact the Oracle Hospitality Consulting Team 
for assistance. 

• The Merchant Name does not support special characters including the & 
character or the @ character and must contain from 5 to 25 characters. 

 
Figure 5-17 OPI Merchant Details Entry Screen 
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8. Click Add Terminal. 

 
Figure 5-18 OPI Add Terminal Screen 
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9. Enter the POS Terminal information using the following settings: 

Table 5-7 OPI POS Terminal Configuration 

Field Value 

Workstation ID Workstation ID in the EMC 

IP PINPad IP Address 

 

 
Figure 5-19 OPI Terminal Information Entry Screen 

10. Click Next and then click Exit. 
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11. Review the OPI Configuration Summary page and click Continue. 

 
Figure 5-20 OPI Configuration Summary Screen 
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12. Click Yes to save the configuration settings. 

 
Figure 5-21 Save OPI Configuration Settings 
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13. Select Yes to restart the computer now or select No to restart the computer at a 
later time to complete installing and configuring the OPI. 

 
Figure 5-22 OPI Installation Completion 
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Configuring the Port for the PIN Pad Terminal Mode 
1. Go to the OraclePaymentInterface folder and go to the bin folder, then 

double-click the config.exe file. 

 
Figure 5-23 Port Configuration for PIN Pad Terminal Mode 
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2. Enter your Microsoft Windows System Administrator credentials and click 
Login. 

 
Figure 5-24 OPI Port Configuration – Step 1 
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3. Double-click the Oracle Payment Interface to expand the folder. 

 
Figure 5-25 OPI Port Configuration - Step 2 
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4. Click server0Q and then double-click the Port setting and enter the correct port 
number for the PIN pad. You must confirm the PIN pad port number with the 
partner. 

 
Figure 5-26 OPI Port Configuration - Step 3 
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5. Restart the OPI Service. 

 
Figure 5-27 Microsoft Windows Services Screen 
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